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AT&T Connect basics

Welcome to the AT&T Connect Participant Application for Mac®. AT&T Connect provides tools for
visual presentation, remote collaboration and voice conferencing. This virtual meeting space lets
you easily share voice, data and video while using existing Internet and telephone resources.

The AT&T Connect Participant Application for Mac is designed according to Apple guidelines, for a
sleek and intuitive user experience.

Related topics

"The users" below

"Localization" on the next page
"Documentation" on the next page

"Download the application" on the next page

The users

Participants, presenters and hosts work with the features of the Participant Application during an
online conference. The maximum number of users in an AT&T Connect conference is based on
contracted limits.

Who does what?

+ Presenter—any participant with presenting rights and who currently has “control” of the
conference. Presenters can load files onto the whiteboard, initiate application sharing, and
perform web tours, polls, and surveys. Presenters can invite additional participants to a
conference, expel participants, and lock a conference. Presenting rights can be passed among
participants as each one presents materials to the group. The title “Presenter” appears next to
the presenter’s name in the Participants list.

¢ Host—the person who starts and schedules conferences and initially has the presenting rights. A
host can give and take the presenting rights from a presenter at any time. A host defines the
conference settings, which can be modified before or during a conference. A host can also assign
co-host status to a participant. The title “Host” appears next to the host’s name in the
Participants list.

o Co-host—a participant who is appointed by the host and shares all the host privileges. A co-host
typically helps the host to manage a conference, especially when there are many participants.
Co-hosts can mute/unmute other participants and rename a phone-only user. The title “Co-
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Host” appears next to the co-host’s name in the Participants List. There is no limit to the number
of co-hosts in a conference.

o Participant—a person who takes part in an AT&T Connect conference. In a conference,
participants can speak, transmit video, use the whiteboard, chat, make announcements, write
meeting minutes, record the conference locally, and access materials from past conferences.

Localization

The AT&T Connect Participant Application for Mac is available in English (default language),
Japanese, Simplified Chinese, Traditional Chinese, French, German and Spanish. The choice of
language is based on the local configuration which you set in your Mac device. This means that you
don’t have to set the language in the application itself since it automatically conforms to the Mac
setting.

Documentation

This User Guide is available in English only. The Quick Start cards are available in all the above
languages. You can find AT&T Connect documentation and other resources at
http://www.corp.att.com/attconnectsupport/.

Download the application

Before joining a conference, you need to download the AT&T Connect application from one of the
following locations:

o Thelink in your email invitation.
Or...

o The AT&T Connect website at http://www.corp.att.com/attconnectsupport/downloads/.

Clicking the link automatically downloads the latest version of the application. The AT&T Connect
icon appears in the Mac User Applications folder and usually on the dock. The icon is displayed on
the launch pad in Lion® and subsequent operating systems.
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Join a conference

You're invited to an AT&T Connect conference and you have a number of ways to join.
Related topics

"Join an unscheduled conference" below

"Join a conference from the source list (quick join)" below

"Join from your Favorites list" below

"Join from your calendar" on the next page

Join an unscheduled conference

o Click on thelink in your email invitation.

Join a conference from the source list (quick join)

AT&T Connect scans your Mac calendar and retrieves upcoming conferences that are scheduled in
the next 24 hours.

1. Inthe Source List window, select the conference you wish to join under UPCOMING
CONFERENCES.
2. Click Enter Meeting.

Join from your Favorites list
First, you need to know how to add a conference to the list.
When participating in a conference:

 Click Add to Favorites from the Conference menu. The conference room remains in the
participant’s Favorites list until you remove it (by clicking Remove From Favorites).

When not in a conference:

o Select the conference in the UPCOMING CONFERENCES or HISTORY lists in the Source List
window and click on the gray banner (with a star in the middle) in upper-left corner of the
detailed view.
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MY CONFERENCE ROOMS
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" s Room C Starts at 10:15 AM. Ends at 10:30 AM.
| UPCOMING CONFERENCES | Anna Clay Benjamin Boone Bertty Brant Jonathan Barrett Jennif

[ ]
FW: Mac Media...arts at 10:15 AM l= Sarah Jones

Mac Client - Dai...arts at 11:30 AM
https://macacc.ucilab.com/samion/meet/?ExEventiD=8133354
CURRENT CONFERENCES

© 's Meeting Room e .
Recurring meeting
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RECORDED CONFERENCES
111lwver

When: 03/04/2012 from 10:15 to 10:30
Where: Room 56 4 floor

The banner changes to orange when this conference is tagged as a favorite.

To join a conference from your Favorites list:

1. Click My Favorite Conference Rooms from the Conferences menu.
2. Select the conference you want to join.

®f AT&T Connect File Edit ViewFarticipants Notes Audio/Video Shared Content Window Help

Write Meeting Minutes i EM
_ |
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CURRENT CONFERENCES My Favorite Conference Rooms Lall ¥ Marketing Dept.’s Meeting Room

a Add to Favorites | Sales Dept.’s Meeting Room

© g's Meeting Room . =
E Remove From Favorites

RECORDED CONFERENCES
1111.ver

Mark Conference

E Rename Archived Conference 8’
HISTORY Delete Archived Conference
Bos Meeting Room Delete All Unmarked Archived Conferences ing time adjustments.
© g's Meeting Room Conference Settings

g's Meeting Room

MEEEnGIREo r8 oI\ TaToTa) i T2

Join from your calendar

When you accept an invitation to a conference, it is inserted into your iCal® calendar as a meeting.
On the day of the conference, double-click the meeting in your calendar and click the link to the
conference.
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Connect audio and video

When you enter the conference room, the Connection Setup action sheet is displayed for defining
your audio and video presence in the conference. Your options may vary according to company

policy.

Related topics

"Connect your video" below

"Connect your audio" on the next page

"Choose your default audio connection" on page 15
"Mute your microphone" on page 15

"Reconnect audio and video" on page 16

Connect your video

o Click Connect with Video & Audio. You'll see a preview of yourself as it will be displayed to
the other participants.

Connection Setup
Please select your audie/video presence
in this event

9 ®

Connect with Connect with
Audio Video & Audio

Choose your audio connection method:

() %/ callmeat... |m|
Q O Voice over computer

() \E Dial-In (Open instructions)

i |
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Connection Setup
Please select your audie/video presence
in this event

Connect with Connect with
Audio Video & Audio

Preview

Choose your audio connection method:

(&) %) callmeat... [ 2321312131 %
C;' O Voice over (nmputer.

() & Dial-In (Open instructions)

i | [ Aosly )

Connect your audio

1. Click Connect with Audio or Connect with Video & Audio.
2. Choose from Call me at, Dial-in or Voice over computer.

Related topics
"Use the Call Me feature" below
"Use voice-over-computer (VolP)" on page 15

"Dial in to the conference" on page 15

Use the Call Me feature

If your company has enabled the Call Me feature, you can asked to be called when joining a
conference. To do so, you first need to set up your phone numbers in the Audio Settings tab of the
Preferences action sheet.

1. Select the Call me at ... radio button in the Connection Setup action sheet.
2. Click on the Settings button to open the Audio Settings action sheet.
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Choose your audio connection method:

((» * call meat... | settings... =

() [_) Voice over computer
() %# Dial-In (Open instructions)

Audio Settings

'e 00

General Accounts Sharing

Audio Settings

Choose your default audio connection:
(Jvoc
(callmeat ...

(_)Dial in

My call me at numbers:

Description |e.g. Office, Mabile, etc.

Number : +1 |Area code+Number

Click on the plus button (+) in the lower-left corner of the numbers list (which will be empty
the first time you add a number).

Type in a descriptive label (optional).

Click on the flag button and select your country from the list for adding the area code.

Typein the phone number (must be at least eight digits).

Repeat steps 3-6 for as many numbers as you wish.

Close the Audio Settings action sheet. The first number you set replaces Settings ... in the
Connection Settings action sheet.

To use the Call Me feature:

1.

2.
3.

Select the Call me at... option and chose the phone number from the drop-down list. (Your
phone numbers were set in AT&T Connect/Preferences/Audio Settings.)

Click Apply.

When called, continue according to the operator’s instructions.

Note: The Call Me feature automatically remembers the last 10 numbers dialed.

Published: 04/15/2016 AT&T Connect® Participant Application for Mac® User Guide 14
Product version: 11.6 © 2016 AT&T Intellectual Property. All rights reserved.



Use voice-over-computer (VolP)

1. Select Voice over computer to use a microphone and speakers, or a headset.
2. Click Apply.

Dial in to the conference

1. Select Dial In (Open Instructions) and click Apply to open the Dial In instructions window.

800 Dial In Instructions

Call Me
Click the Call Me button below for ATA&T Connect to call you

Dial In

Dial one of the numbers listed below.
(Ifyou're at a listed office location, dial the On-site number first)

Toll free (in 98775):
Caller paid (dial to 88775):

On-site number: Select a location... *

Access Code
Enter this code when you are prompted

Host Password
Enter this code when you are prompted

———

s

| Close || callMe |

2. Follow the instructions in the window to dial into the conference.

Choose your default audio connection

Choose your default audio connection in the top area of the Audio Settings action sheet. This
setting affects the current conference and the next time you enter the conference room.

1. Click AT&T Connect on the main menu, and then click Preferences/Audio Settings.
2. Select the VOC, Call me at..., or Dial in radio button.

Note: Once selected, you cannot deselect your choice for the current conference.
Mute your microphone

o Click the Mute button on the toolbar, or select Mute in the Audio menu. Or use the
Command + Shift + M shortcut.

Note: If you want to mute your microphone automatically when joining a conference, click the
AT&T Connect menu and then click Preferences>General>Auto mute upon joining.
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Reconnect audio and video

If your audio and video were disconnected during a conference, it’s easy to reconnect. (You can
also use this option if you joined a conference without setting audio and video.)

o To open the Connection Setup action sheet, click Choose Media Device from the
Audio/Video menu on the top menu bar.
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4 Understand the interface

Once you are connected to the conference, you enter the virtual conference room. Welcome!

Welcome,
L absoust using ATRT Connect for Mac
Wb L ) Mip o urmsie g e aphoed e g the tomtreee
= L]
Rgkp gresseman Ty
L :: [
s s s v @ Wh iteboard| T — iy
Warags 1 EeaFasE 8 Covadd Hall & ¥
i & 2: E f 2
—— ’ Participants Panel
[rrpey & [T T——
e ® |
Tiir wttrimnind iagtadn B mml -
Vi b it a
o Meeting Minutes
Panel

F o

s &

% =———x  Whiteboard Controls

Related topics

"Toolbar buttons" below

"Participants panel" on the next page

"Video panel" on page 19

"My Meeting Minutes panel" on page 19

"Whiteboard panel" on page 19

Toolbar buttons

Note that active buttons are blue and disabled buttons are grey.
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Button Description

Shows or hides the Source List.

For participants, lets you leave the conference. For hosts, opens an action
sheet where you can specify whether to end or leave the conference.

Enables presenters to share their desktop application with all conference
participants. See "Share your desktop applications" on page 48.

Creates a poll (presenter).

Selects an emoticon that is displayed to other participants. See "Use
emoticons" on page 29.

Turns your video on or off. See "Use video" on page 23.

Mutes or unmutes your microphone and displays audio status.

= e e = N e =

E Shows or hides the Video, Participants and Meeting Minutes panels. This
can also be done from the View menu.

Participants panel

The Participants panel lists the participants in the conference, their roles, chat indications, devices,
audio connection, video status and emoticons. The names of the participants are in black and
sorted alphabetically. The names of hosts, co-hosts and presenters are shown at the top of the list
in pink. Columns in the panel can be sorted in ascending or descending order by clicking the
column header. You can search for a participant in the box at the bottom of the list.

Related topics

"Participants panel icons" below

Participants panel icons

Description

Indicates that the participant is speaking.

ey

@ Indicates that the participant has an audio device but is not speaking.
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Icon Description

& Indicates that the participant is muted.

Indicates that the participant is muted and locked.

Indicates that the participant’s audio is not available.

Indicates that the participant is connected by phone only.

Indicates that the participant’s video is on.

Indicates that the participant’s video is off.

@ @ G &

Example of emoticon.

Video panel

o Forinformation on the Video panel, see "Use video" on page 23.

My Meeting Minutes panel

The My Meeting Minutes panel is for writing meeting minutes or personal memos during a
conference. In this panel you can also view the snapshots which were taken in the conference.

Related topics
"Write meeting minutes" on page 28

"Save whiteboard content" on page 23.

Whiteboard panel

During a conference, you can view content that the presenter placed on the whiteboard. Content
can include inserted materials, shared applications, web tours, poll results, and more.

Related topics
"Whiteboard buttons" on page 21

"View content on the whiteboard" on page 21
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5 Participate in a conference

Now you’re ready to participant in an AT&T Connect conference and use all the great conferencing
features.

Related topics

"Invite others during a conference" below

"View content on the whiteboard" on the next page
"Use video" on page 23

"Send a note" on page 25

"Write meeting minutes" on page 28

"Use emoticons" on page 29

"Participate in a poll" on page 30

"Play back a recording" on page 31

"Access past conferences (source list)" on page 32
"Report a problem" on page 34

"Submit a telephony ticket" on page 35

"Set general preferences" on page 36

"Leave the conference" on page 36

Invite others during a conference

Do you have a colleague who might be interested in the conference? As a participant, you can send
an invitation on your own.

1. Inthe Participants panel, click the Participants button and then click Invite others by mail.
Or, in the Participants menu, click Invite Others by Mail. This opens an email invitation in
your default email application.

2. Add the email addresses and click Send.
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View content on the whiteboard

View content that the presenter placed on the whiteboard, including inserted materials, shared
applications, web tours, and poll results. As with all the panels, while viewing the whiteboard you
can still control your audio, choose emoticons, write notes and minutes, and view the Participants
panel.

. RCI RN e e N v A ina

|

AT&T Connect

le

J,__’;‘_*-;_T= DJ‘OT'I‘I'.'.!'_';_ _J
Related topics
"Whiteboard buttons" below

"Whiteboard annotation tools" on the next page

"Save whiteboard content" on page 23

Whiteboard buttons

Buttons on the bottom left of the whiteboard let you control the display and take snapshots of the
content.

Button Description

H Displays the content on the whiteboard at the optimal size so that it is all
visible on the whiteboard using its maximum size while keeping the original
ratio.

M e={ Jm= [ | Shrinks or enlarges the content display on the whiteboard. The zoom range
Zoom (100%)
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Button Description

is from 25% to 400% of the original size.

Whiteboard annotation tools
You have a number of options for working with content displayed on the whiteboard.

1. Click the Annotations button at the bottom-right of the whiteboard to open the annotation
toolbox.

2. Choose atooland express yourself! You can:

o Draw shapes lines and free forms

o Add colors

o Use the pointer, which displays your name with the pointer to the other participants.
o Eraseyour drawings

o Clear the whiteboard (for presenters only)

Using the text tool

You have tools for defining the text annotation area, choosing the font, size and color, and using
the built-in spelling checker. Before sharing your text with the other participants, you are asked for
approval.

1. Click the Text button (it looks like the letter “T”), which opens the popover for choosing the
font size.

10
16
24
36 |
48
64
96

LS
070 1272,

2. Select the desired font size. This opens the text box.
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3. Type or paste your text. The text box automatically adjusts to its content. You can:

e Manually expand the text box and move it around the whiteboard (by clicking and

dragging).
o Select the text and change its color, using the Mac color palette (click the button with
the ball icon).

4. When you are satisfied with the text, click the blue check button to display the text on the
participants' whiteboards.

Save whiteboard content

o To take a snapshot of whiteboard content and annotations, click the camera button in the
bottom center of the whiteboard.

Snapshots are displayed in the Snapshots tab of the My Meeting Minutes panel. You can view
multiple snapshots as a slide show using the Forward and Back arrows. Snapshots are also saved in
the Source List under HISTORY.

Relate topics

"Access past conferences (source list)" on page 32

Use video

You can simultaneously view up to six videos in the Video panel, with the six most-recent speakers
in view. The current speaker is displayed in a larger frame than the other streamed participants.

Clicking the Video button “registers” your intention to transmit video. Clicking the button again
“un-registers” you and you will no longer transmit video even as an active speaker.
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Note: The number of streams you can see in a conference depends on your bandwidth settings.
To enable video:

1. When joining the conference, click Connect with Video & Audio in the Choose Media
Device action sheet. This opens a preview of how the participant’s video will be broadcast.

2. Click Apply to open the video panelin the upper-right corner of the window, with up to five
additional video screens of other conference participants. These screens are labeled with the
participants’ names.

Related topics

"View only the speaker" below

"View video on the whiteboard" on the next page

"Extract and dock the video panel" on the next page
"Maximize the video panel (detached mode)" on the next page

"Stop video transmission" on the next page

View only the speaker

o Click Follow the Speaker in the Video panel menu, or click Follow the Speaker in the
Audio/Video menu.
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View video on the whiteboard

1. Click the “Swap” button in the upper left corner of the Video panel.

2. Toreturn to the default-view, click the “Swap” button in the upper left corner of the reduced
whiteboard panel.

Extract and dock the video panel

o To extract, select Extract Video Panel from the View menu and drag the detached window to
the desired location. (Extract Video Panel toggles to Dock Video Panel.)

o To dock, select Dock Video Panel from the View menu, or click the red button in the floating
window toolbar.

Maximize the video panel (detached mode)

o Click the green button in the Video toolbar. Click again to minimize.

Stop video transmission

1. Click the arrow in the upper-right of the Video panel to open the menu.
2. Click Stop Sending my Video.

Send a note

You can send three types of chat-like notes during a conference: private notes, public notes
(announcements), and notes to the presenters’ group.

Note: Sending notes is dependent on company policy.
Related topics

"Send a private note" on the next page

"Detach a note" on the next page

"Send an announcement" on the next page

"Send a note to the presenter's group" on page 27

"Configure note settings" on page 28
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Send a private note

1. Double=click on the participant’s name in the Participants list to open the note popover with
the curser in text box.

e (thmy Participants (4) v
:;I,i,'c_:‘::i;:?gﬂ%m think about this Name = @ ® g
Anna Clay (Host) @ \;y
David Hall ® ©® &
Thanks... o Kelly Stone ® O ¢
Mike Novak ® ol

-IT'\";.‘Q here. Press Enter to send

4

2. Write your note in the text box and press Enter on the keyboard.

The receiver hears an audio signal and the sender’s name and the first line of the note is
displayed in the blue status display in the toolbar. A blue dot appears to the left of the sender’s
name in the Participants list. Double-clicking the blue dot opens the popover with the new
note. The blue dot changes into an empty dot outlined in gray which indicates that there is an
open conversation with the participant but no new note has been received.

Detach a note
You can detach a note to open multiple chats simultaneously.
o Select and drag the note to any location on the whiteboard.
Send an announcement
Send notes to all the participants (if company policy allows).

1. Click on the Announcement button in the upper left corner of the Participants list to open
the announcement action sheet.

Published: 04/15/2016 AT&T Connect® Participant Application for Mac® User Guide 26
Product version: 11.6 © 2016 AT&T Intellectual Property. All rights reserved.



Announcement
Kelly Stone 5:23 PM
4 minutes left

Kelly Stone 5:23 PM

I have to go

Kelly Stone 5:24PM (e my

Cood presentation! —

Lz 5:24 PM Anna (

Thanks .

David

Type here. Press Enter to send o Kellv S

> Mike N

2. Write your announcement in the text box and press Enter on the keyboard. The received
announcement is displayed with the sender’s name. Additional announcements are added
to the popover as they arrive.

x Kelly Stone:
4 minutes left

» Kelly Stone:
| have to go
x Kelly Stone:

Good presentation!

Reply to an announcement

o Click the announcement to open the popover. If the popover is closed, click on the
Announcement button to open the popover with all the announcements listed in
chronological order.

Send a note to the presenter's group

Send a note to the members of the presenter’s group, which includes the presenter, the host and
the co-hosts. Each member of the group can send you a private reply.

1. Right-click anywhere in the Participants list and select Send Note to Presenter. Or, click on
the arrow in the Participants list to open the action menu and select Send Note to
Presenter. Or, select Send Note to Presenter in the Notes menu on the main menu.

2. Typeinyour note and press Enter.
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800 Presenters
Current presenters:

| Wiew All.

Select addressee

Configure note settings

1. Click AT&T Connect, then Preferences..., and then General.

o General

C— I~ —
8] & - (&
General Accounts Sharing Audio Settings

My Information

First Name: Anna Last Name: Clay

Email Address: annaclay@abc.com

Auto mute upon joining

Auto save notes

Auto open private conversations
Automatically send future crash reports

Play a sound alert upon: Someone raising hand
Getting new note
Don't play sound alerts: When I'm a presenter

2. Check or uncheck the following options:

o Auto save notes for automatically saving all the conference notes in the conference’s
history when exiting a conference..

o Auto open private conversation for automatically opening the note in a floating
panel.

o Play a sound alert upon: Getting new note

Write meeting minutes

Click in the Memo tab of the My Meeting Minutes panel and start typing. Or, click Write Meeting
Minutes in the Conference menu on the main menu bar. Your minutes and snapshots are saved in
the Source List under HISTORY.
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Related topics
"Send meeting minutes and snapshots" below

"Access past conferences (source list)" on page 32

Send meeting minutes and snapshots

Send meeting minutes and snapshots as attachments by email during a conference or from past
conferences.

1. Click the Forward button in the upper-right corner of the panel to open an empty email

message with the attached minutes.
2. Typeinthe address(es) and optional message, and then click Send.

LN

Send from the Source List

1. Select the conference whose materials you want to send under HISTORY.
2. Click Forward Materials from the History Options menu.

History Options
Forward materials

Email all

Copy names

Use emoticons

Express yourself in the conference with emoticons. Raise your hand to notify the presenter that
you want to speak, or indicate that you have temporarily stepped out of the conference.

_| *ﬁj Step Out l—

™ Raise Hand ¥R
© Happy

& Unhappy
1’ Agree

) Disagree
% Applaud

£ Can't Hear
% Understand
(?) Confused
(®) Go Faster
[®] Go Slower
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1. Click the Emoticon button in the toolbar, or select Set My Emoticon in the Participants
menu.

2. Choosethe emoticon that suits your state of mind and click it. The Emoticon button
changes to the state you chose and the participants see the emoticon next to your namein

the Participants list.
3. To clear the emoticon, click the Emoticon button again, or select Clear Emoticon in the

Participants menu.

Participate in a poll

Your presenter may want you and all the other participants to voice your opinion about an issue in
a poll. There are two types of polls: those with a Yes or No response and those with an OK
response.

When the presenter asks the polling question, one of the following action sheets are displayed on
your Mac:

Respond to Poll
Select your response:

| Ignore | No | [ Yes J

Respond to Poll
Select your response:

| Ignore | [ OK |

o Click your response, depending on the type of question the presenter asked.
Related topics

"View the results" below

View the results

If the presenter chooses to share the current results of the poll, a graph is displayed on your
whiteboard based on the presenter’s graph. Each answer is displayed with a ratio of the number of
participants who selected that option out of the total number of participants, and a graphic
representation of that number.
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Anna Clay is speaking (

i

BesE.ee0
|

Poll Results

Fit Content Zoom (100%)

Play back a recording

iy Participants (4)
[Name

“

©,6,0,0,0
(€}

Anna Clay (Host)
David Hall

Kelly Stone

Mike Novak

o e
10 5 e 4

QSearch Participants

My Meeting Minutes

TN snapshots |

O72e T/ e/

You can play back VCR recordings of the conference on your Mac.

1. Click Open Recorded Conferences in the File menu to open the Mac finder and select the
desired recording, or double-click on any VCR file located on your Mac.

I
RIS

im |[ & v || (Jaccl76.uclabs.co...61... 3| (Q
FAVORITES Debug_Recording » [ acc176.ucla.. 525330687 l-
m s History » [ acc176.ucla...525332105 EventData.plist
L Log » [ accl76.ucla...485111286 * MeetingMinutes.txt
#% Applications _ogs » [ acc176.ucla...015110452
[ Documents Materials » [0 acc176.ucla...015110638 =
£ All My Files ParticipantAppData [ accl76.ucla...015110671 *
(] acc176.ucla...01$110931  »
(£ Internet Plug-Ins [ acc176.ucla..015111037
[T AutomaticBuilds [ acc176.ucla...015330022
ATT Connect [ acc176.ucla...015331787
I ATT Connect

(] acc176.ucla...01§332293
SHARED [[] acc176.ucla...015332554 »
[E 10.10.4.10 A [ accl76.ucla...015332746  ©
. [ acc176.ucla...015332759
g S iMac [ acc176.ucla...015333078
[ bezeg (] acc176.ucla...01$333080
[E] digler (] acc176.ucla...015333107 =
q [ acc176.ucla...015333221 *~
[E] il [ arc176 urla N1533325 IS

[ Cancel |

This opens the Source List window with the recording in the Playback panel, and name of
the recording is displayed under RECORDED CONFERENCES.
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2. Click on the Play button (which toggles to Pause) to start the playback, displaying the
recorded content on the whiteboard. Or, select the File menu/Playback/Play. The slide bar
shows the playback progress.

8 Nospeker

|||||||

Temperature anomaly (*C)
s &
Temperature anomaly (*C)
o o =
s &

g
g
HEl
g
g
H
g

Tmperature anomaly (°C)
S &

|

1950
Year

H

models using anly natural forcings s obssrVations

models using both natural and anthropagenic forcings

X om m a
Fit Comere Zoom (1005

The recording is divided into segments which can be played separately.

3. Click on the segments or on the Previous and Next buttons to jump to the various
segments.

Note: In addition to playing the recording from the Playback menu, you can also save a copy of the
recording, replay the recording from the beginning (Rewind) and jump forward to the recording

segments (Forward).
Access past conferences (source list)

Access information about past conferences in the Source List, including the list of participants,
meeting minutes, snapshots, recordings, and other meeting materials.

1. Ifthe Source List is hidden, click the Source List button to open the Source List window.
8

2. Select a past conference from the left panel under HISTORY to view the information.
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Ceo=® @0

G EE

MY CONFERENCE ROOMS
4@....com's Room © Anna Clay’s Meeting ROOm

Room Hosted by: Anna Clay

UPCOMING CONFERENCES @ ol conference information
FW: Mac Me... at 10:15 AM

Mac Gl - ot 11,30 A @© 11/20/2012 | Started at 16:47, Ended at 17:09

CURRENT CONFERENCES 22 innag Asaf asasas ozr elad B
s Meeting Room 0

RECORDED CONFERENCES

11114
ver Meeting Minutes

HISTORY
Meeting Room
Meeting Room Conference Name 's Meeting Room
#44's Meeting Room Started at : 1120012 17:10
20/12 10:27
1..20/12 10:21
19/12 17:26
BRI /19712 09:29 (exp: 17:20 Snapshot-1.tif)

Action Items:

..04/12 0917 (exp: 17:20 Snapshot-2.1iff)
1..24/12 08:49
1..23/12 00:03
118/12 11:34
..16/1213:23
1..15/12 09:21
1...07/12 10:56
012 1557
& |(Qsearch Conferen

(exp: 17:20 Snapshot-3.tiff)

lovm 17:20 Snanchar-4 1)

Snapshots

History Options
Forward materials
Email all

Copy names

Conference Materials

Poll-6. - Note

The top of the Source List displays the conference’s date and start/end times. The names of the
participants are also displayed. In the top-right corner is the History Options menu with the

following options:

o Forward materials for sending all the conference materials as email attachments.
o Email all (available only to hosts) for sending an email message to all the participants

in the conference.

o Copy names for copying all the participants’ names for pasting into any document for

follow-up purposes.

e The lower part of the window contains the Meeting Minutes, Snapshots and

Conference Materials panels. The Meeting Minutes, Snapshots and Conference
Materials panels provide you with the details of the conference that you selected in

the HISTORY list.
Related topics
"View meeting minutes" below

"View snapshots" on the next page

"View conference materials" on the next page

View meeting minutes

1. Scroll down the Meeting Minutes panel to view the minutes, including reference to the

corresponding snapshots.

2. To open the snapshot file in the Preview application, click the Preview button above the

panel.

Published: 04/15/2016 AT&T Connect® Participant Application for Mac® User Guide
Product version: 11.6 © 2016 AT&T Intellectual Property. All rights reserved.

33



3. To send the file as an email attachment, click the Send button above the panel.

View snapshots
o Click the Forward and Back arrows to view the snapshots in a slide show.
View conference materials

View poll results, notes, recordings and more.

o Click on the item and then click on the File button to open the folder (Poll, Recordings,
Notes,etc.) containing desired file.

Related topics

"View meeting minutes" on the previous page

Report a problem

AT&T Support wants to hear from you with any problem you may be experiencing with the
Connect application.

1. Select Submit Logs in the Help menu to open the Report a Problem dialog box.

® Report a Problem

Please enter detailed description of the problem.

Report ID: 6B07-9D2B

» Legal notice

carce | (I

2. Write a detailed description of the problem and click Send Report.
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The Report ID is a random number that identifies your report. If you want to send an email to
AT&T Support after sending the report, make sure to include the Report ID.

Submit a telephony ticket

If you have a problem with the connection and/or voice quality of a conference, you can open an
online ticket during a conference in the Submit a Ticket window. After entering the details of your
problem, the ticket is automatically sent to AT&T Support and a confirmation email is sent back to
you.

Note: This feature depends on company policy and may not appear in your application.

1. Select Submit an Audio Conferencing Trouble Ticket in the Help menu to open the Submit
a Ticket window.

Problem Description

Date & Time of Incident - v -
Select Category -
Select Sub-Category -

Number you Dialed
[F] AT&T conference called me

Description

Phone Details
Called from this Mumber
Type -

Country -

Your Contact Details

Full Name
Contact Email

Contact Phone Number

Type the digits you see in the picture below

===

o For genera | assis tance, please ca Il ATET Support Center
£oat (US Only) or (US or International).

2. Enter the required information and click Submit. The AT&T Support Center will contact you
to resolve the problem.
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Set general preferences

1. Click Preferences... on the AT&T Connect menu to open the AT&T Connect Preferences
window.
2. Click General to open the General tab.

[ J General

s QS ——

== 0!
8w G
General Accounts Sharing Audio Settings

My Information

First Name: A Anna Last Name: Clay

Email Address: annaclay@abc.com

Auto mute upon joining

Auto save notes

Auto open private conversations
Automatically send future crash reports

Play a sound alert upon: Someone raising hand
Getting new note
Don't play sound alerts: When I'm a presenter

3. Typeinthe name you wish to appear in the Participants list.

4. Typein your email address. The host uses this address when sending email from the Source
List. It does not appear in the Participants list.

5. Check (or leave unchecked) your preferences for:

o Automatically muting your microphone when joining a conference

« Automatically saving all the conference notes in the conference’s history when exiting
a conference

o Automatically opening a note (conversation) in a floating panel

o Automatically sending crash reports without being prompted

o Playing sound alerts

Leave the conference

o Click the Exit button on the toolbar or select Exit Conference from the Conference menu.

Published: 04/15/2016 AT&T Connect® Participant Application for Mac® User Guide 36
Product version: 11.6 © 2016 AT&T Intellectual Property. All rights reserved.



6

s

'rs

Host capabilities

As the host, you have many options for configuring, creating and managing your conferences.
Related topics

"Activate your account from the registration email" below

"Activate your account after downloading Connect" below

"Configure conference settings" on the next page

"Use Broadcast mode" on page 41

"Start a conference" on page 41

"Invite participants" on page 41

"Schedule a conference" on page 42

"Manage the participants" on page 44

"Manage the conference" on page 46

Activate your AT&T Connect account

Before hosting a conference, you first need to activate your AT&T Connect account. Once activated
AT&T Connect is launched with the preferences you set for your account.

Related topics
"Activate your account from the registration email" below

"Activate your account after downloading Connect" below

Activate your account from the registration email

o Click on the activation link in the registration email you received when you registered with
AT&T Connect.

Activate your account after downloading Connect

When you open AT&T Connect for the first time after downloading, a screen opens for you to fillin
your name and email address.
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7%

Your Details

This is how you will be identified in the conference.

| ct®

Cancel

0
s :

« Fillin your details and click OK. The application recognizes that you have an AT&T Connect
account and opens the Activate Your Account screen. Then fill in your host password and
click Activate or click Get Activation Email to request your registration email with the

activation link.
ﬁ Skip

Activate Your Account

Hello Bob Smith,
To activate your account on this device, " C1
enter your host password.
Bobs@company.com (change)

or

Get Activation Email

Start

Configure conference settings

AT&T Connect is launched with the preferences you set for your account. However, you can change
these preferences at any time. The following conference settings are available:

o iMeeting—allows multiple participants to take a pro-active role in the conference. All
participants typically have similar conference rights and privileges.
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o elearning—a moderated conference in which a teacher-student relationship exists between
the presenter and participants. In eLearning conferences, participants can view the
Participants list and be allowed to pass notes.

o Webinar—a moderated conference in which a teacher-student relationship exists between
the presenter and participants. In Webinar conferences, the Participants list is hidden and
therefore only the host/presenter can see who is attending the conference.

o Voice Only—a conference where all participants are using a phone and not the Connect
application. Telephone access depends on your organization’s AT&T Connect license, and
may not be available in your system.

Related topics
"Change your default conference settings" below

"Change conference settings for a single conference" on the next page

Change your default conference settings

1. Inthe AT&T Connect menu, click Preferences... and then click Accounts. The Accounts tab
automatically displays your account details for the current conference.

‘@00 Accounts

Ry =
General | Accounts | Sharing Audio Settings

__ Room &
Account Name: Room

Ermail; stie  tonm =oatigs isap sns

Account address: s MBS RN S
Conference address: M | SRR ARSI Sl Siaas
| Profile Settings | | Forgot Password |

2. Click Profile Settings and then click Conference Settings to open the Conference Settings
tab.
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o000 Accounts,
q
L+

L
General

Accounts | Sharing Audio Settings

| ¥ Profile Details
» Cannection Details

~ Conference Settings

Settings per Conference Type|? Preferred Conference Type | iMeeting v
eLearning Webinar

() Begin conference in Broadcast Mode

# Allow all participants to draw an the whiteboard

# Allow only participants in the broadeast group to draw on the whiteboard
™ Allow participants to record locally

™ Allow notes amang participants

# Allow participants to send notes to host, co-hosts and presenter

© Allow the use of emoticons

# Allow participants to insert materials (relevant for PC users only)

# Allow participants to view the materials list (relevant for PC users only)

 Allow participants to view the Participants list

3. Select your Preferred Conference Type from the drop-down list at the top-right of the tab.
4. Click the features and behaviors you want to enable for this conference type.

Change conference settings for a single conference
You may want to change the features and behaviors of the current conference you are hosting.

1. Inthe Conference menu, click Conference Settings to open the Conference Settings
window.

8. .00 Conference Settings

Whiteboard Settings EA”OW all participants to draw on the whiteboard

Video, Audio, EA”UW participants to record locally
Recording 3 Allow the use of video
[gn.llow volce-over-computer

Policy EA”OW chat among participants
@Allow participants to chat with presenters
EA”OW the use of emoticons
[ Allow participants to insert materials (relevant for PC users only)
EA”OW participants to view the Materials list (relevant for PC users only)

™ Allow participants to view the participants list
Changes will only apply to the current conference

| Cancel | | Save |
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2. Click the settings you want for the current conference.
3. Click Save.

Use Broadcast mode

Broadcast mode permits only specific users to speak. Typically this mode is used for lecture-type
presentations or for an “expert forum”. In this mode, the focus is on the presenter and the
materials being shared with the group. All participants are in the muted and locked state except for
the presenter, host and co-hosts.

1. Click Broadcast mode in the Conference menu.
2. To exit, click End Broadcast mode.

Tip: A presenter can unmute and unlock participants while in Broadcast mode.

Start a conference

o Click the Start Conference button in the meeting room screen to enter your conference
room.

AT&T Connect®

-° Uy
[ ]

Start Schedule ~

8[8](Qsearch Conferences

Note: When starting a conference, you may be asked to define a security code for the conference
(depending on your company policy). If so, a window pops up for you to type in a security code of
four to nine characters. When prompted, participants will need to enter this code to join the
conference. Typically, you add this code to the email invitations that you send to the participants.

Invite participants

Once you enter your conference room, it’s time to invite the participants.
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Related topics
"Invite by copying the conference address" below
"Invite participants by phone" below

"Dial out to participants" below

Invite by copying the conference address

¢ Click My Conference Room to open the menu and then click Copy My Conference Room’s
address. This copies the conference link and dial-in instructions to the clipboard and lets you
paste it into an email or instant messaging window.

Invite participants by phone

If the Call Me feature is enabled for your host account, you can invite participants to a conference
by phone.

1. Click the Participants button and then click Invite others by phone. Or click Invite Others by
Phone in the Participants menu.

Name:

| Cancel || Call Now |

2. Typethe name of the person you want to invite, select the country, and type in the number.
3. Click Call Now.

Dial out to participants

If company policy allows, you can dial out to a participant who is connected to the conference data,
but not to audio.

1. Right-click the participant and click Dial out to Participant from the menu.

2. Select the country and then type in the number (the participant’s name has been
automatically filled in).

3. Click Call Now. The called party hears an automated voice greeting welcoming him/her to
the conference.

Schedule a conference

You can schedule a future conference using the Microsoft Outlook 2011 or iCal applications.
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1. IniCal, click the Schedule button in the meeting room screen to open your default

scheduling application window. A calendar event is automatically opened whose start time is
within one-half hour of the current time. By default, this conference is scheduled for one
hour. The conference also contains a link for entering the conference.

iCal

[+] 0o TP voren [+ |

Israel Standard Time v |

Q-

ON MY MAC Sunday, Des 11

Monday, Des 12

NOTIFICATIONS

computer):

1. Choose one of the follow-
ing numbers to dial

|
I — If you are calling from an of-
G0 e

rest —

Edit Done

ExEventiD=8299754

AW Follow-Up discussion for
| Agple Connect Early Feedback
ragram — See AT&T Connect

(e300
Roi - weekly — Vadim's Detais Below

Tuesday, Dec 13 Wednesday, Doc 14 Thursday, Dec 15 Fiiday, Doc 16 Saturday, Des 17
# Calendar
¥ Holiday
& Home | | |
oo 00 Aor 500 A [@00AM 300
# Work PC Discovery t4PE Discavery team PC DiscoyPE Discoy R-téam —
 AT&T Connect Events — De-Gaulle |— Conference [tear — (team — [anab room
= oo~ Aripuana ference Riaulle
INTERWISE ) Aripuana
e Weekly meeting
& Home
 UI-Dev Process - UI T. location
A Tasks (EEsoAm ExEventiD=8209754
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Conference Rogm=
Aripuana — (Sprift - Daily — ®]Sprint - Daily — [Sprint - Dy — S[Sprint - Daily — | from 12/14/2011 10:00 AM [sorint - Daity—
= 10 12/14/2011 11:00 AM
. time zone GMT+00:00
note You are invited to attend an
AT&T Connect iMeeting .
To connect to the Web Con-
ference
Click here: https://
oo o
Mac phase 2 discovery team — | Weekly meeting —Ray's - room ‘
I ——j TO CONNECT WITH YOUR
Weekly Mecting-Roy kina — || “TELEPHONE ONLY* (n0
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bt R
veyse | [ Dectes | | Accest
‘SAVE THE DATE

a e
e | [ Deciee | Accent
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2],

2. Click the Add Invitees... link and type in the names of those you wish to invite, or add them

from your local address book.

3. (Optional) Add attachments to the invitation.

4. Click Send.
Related topics
"Change the conference type" below

Change the conference type

When scheduling a conference, you can change your default conference type.

1. Inthe meeting room screen, click the arrow next to the Schedule button to open the drop-

down list.

Schedule v

2. Select the new conference type.
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Related topics

"Configure conference settings" on page 38

Manage the participants

You manage the participants in your conference using the options Connect provides for hosts.

Related topics

"Assign a co-host" below

"Give presenting rights" below

"Clear emoticons" on the next page

"Expel a participant"” on the next page

"Muting options" on the next page

Assign a co-host

To help you host the conference, you can assign co-host status to a participant. Co-hosts have the
same privileges as the host and can perform many of the same actions. Co-hosts can:

Determine which options to give to participants.

Send notes to all participants at once (when this option is not available in the conference
for regular participants).

Reply to notes that were sent to presenters.

Activate Broadcast mode.

View the Participants list when this option is not available in the conference for regular
participants.

Give and take presenting rights if the host leaves the conference.

To assign a co-host:

1. Select the participant in the Participants list, and in the Participants menu click Change Role
to/Co-Host. Or, right-click the participant in the Participants list and click Co-Host on the

menu.
2. Toremove the Co-Host role, click Change Role to/Participant, or right-click the participant

and click Participant on the menu.

Give presenting rights

Do one of the following:

« Inthe Participants list, right-click the participant and click Give Presenting Rights/Take
Presenting Rights.
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Or...
« Inthe Participants menu, click Give Presenting Rights/Take Presenting Rights.
Clear emoticons
o Click Clear All Participants Emoticons on the Participants menu.
Expel a participant
Do one of the following:
o Inthe Participants list, right-click on the participant and then click Expel.
Or...
« Click on the participant in the Participants list, and click Expel from the Participants menu.
Or...
o Click Expel from Participants main menu.
Note: An expelled participant can’t re-enter a conference.
Muting options
Mute/unmute a participant
Do one of the following:

o Inthe Participants list, right-click the participant whose microphone you want to mute and
click Mute/Unmute.

Or...

o Select the participant in the Participants list and in the Participants menu, click Mute
Participant/Unmute Participant.

Note: Participants can unmute their microphones after being muted by the host.
Mute and lock a participant
When a host mutes and locks a participant’s microphone, the participant can’t unmute.

o Select the participant in the Participants list, and in the Participants menu click Mute and
Lock/Unmute and Unlock.

Mute/un-muting all

Do one of the following:
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o Click Mute All/Unmute All in the Participants menu in the Participants list.
Or...
e Click Mute All/Unmute All in the Participants menu.

Note: Participants can unmute their microphones after being muted by the host.

Manage the conference

You manage your conference using the options Connect provides for hosts.
Related topics

"Change the conference name" below

"Lock the conference" below

"Record on the server" below

"Set sharing preferences" on the next page

"End or leave the conference" on the next page

Change the conference name

You can specify a new name for the conference. The new name replaces the old one in the title bar
of the conference window and in the Source List under HISTORY.

o Click Change Conference Name in the Conference menu to open the Change Conference
Name action sheet.

Lock the conference
When you lock the conference, new participants can’t join even if they were invited.

1. Click Lock/Unlock Conference in the Conference menu.
2. Typeinthe new name and click Continue.

Record on the server

You can record your conference on the application server. Recordings are automatically placed in
the conference’s history at the conclusion of the conference, under Recorded Conferences.

Note: Downloading the recording from the server to the conference’s history may take some time.

1. Click Start Recording in the Conference menu. You are notified in the status display that the
conference is being recorded.
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® REC Conference is being recorded

2. To end the recording, click Stop Recording in the Conference menu.
Related topics
"Access past conferences (source list)" on page 32
Set sharing preferences

In the Sharing tab you can specify the bandwidth consumption you want to use for application
sharing.

e 0o Sharing
3 n ) -
S =y O
General Accounts | Sharing | Audio Settings
Output bandwidth control: | | Normal (some participants use a fast connection)

@High (all participants use a fast connection)
( | Low (all participants use a slow connection}
() Custom Bandwidth: 64 (kbps)

Set the average bandwidth consumption you wish to use.

1. Click Preferences... on the AT&T Connect menu to open the AT&T Connect Preferences

window.
2. Click Sharing to open the Sharing tab.
3. Click one of the following: Normal, High, Low and Custom Bandwidth. If you selected

Custom Bandwidth, set the bandwidth in kbps.
Related topics

"Share your desktop applications" on page 48

End or leave the conference

You can either leave the conference while keeping it alive for the participants (maybe you’ve
assigned the role of co-host or presenter to a participant). Or, you can end the conference and
disconnect all conference participants.

1. Click the Exit button on the toolbar, or select Exit Conference in the Conference menu. A
message is displayed asking you if you wish to leave or end the conference.

2. Click End Conference or Leave Conference. A confirmation window is displayed, reflecting
the option you selected. If you chose to end the conference, the participants are notified.
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Presenter capabilities

Connect provides you with many options for presenting materials, as well as conducting polls and
web tours.

Related topics
"Share your desktop applications" below
"Create polls" on page 50

"Conduct a web tour" on page 54

Share your desktop applications

1. Click the Share button or select Start Sharing from the Shared Content menu to open the
Share action sheet.

T
Select what you wish to share:

@ Desktop
() Applications/Windows

(J B Calendar

[ &  Finder

[J @ Coogle Chrome
O@ Mail

(J @  Microsoft PowerPoint
[ &  Safari

| Cancel | | Start

2. To share your desktop with others, select Desktop.

Important! If you’re in full-screen mode and switch to a new or different space during the
shared session, all the participants will see the new space as well.

3. Or, to share applications, select Applications/Windows and then check the ones you want
to share. The desktop background and all other applications and popovers will be dimmed.
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Select what you wish to share:

() Desktop
(=) Applications/Windows

[/ #  Calendar

[ | &  Finder

M @  Google Chrome
Om Mail

] @  Microsoft PowerPoint
™ &  Safari

4. Click Start. This puts you in Dashboard mode, where the application shrinks to a small
dashboard with the shared content and buttons for various sharing options. A monitor opens
automatically for 10 seconds to let you see what the participants are viewing.

000 ~ AT&T Connect
q No speaker

[LEUGFR - Monmitoring |

Related topics

"Use the dashboard" below

Use the dashboard

The dashboard buttons are described below. You are probably familiar with some of these buttons
from other parts of the application.

. @] (2 Bfdw)
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Button Description

|i| Stops sharing with participants and returns to the standard application

o layout.

|W| Pause/Play button that lets you perform actions on your Mac that are

o undetected by participants.

22 Displays the Participants panel.

| Displays the Meeting Minutes panel.

[ ] Displays the Video panel.

[ ] Expands the dashboard and opens it in Monitoring mode to show what is
currently being shared with participants. Clicking the Updating button lets
you modify what is currently being shared with participants.

Expanded dashboard

Illustrated below is the expanded dashboard in Monitoring and Updating modes.

RERER AT&T Connect | | ©0C AT&T Connect

| No speaker

Calendar
Finder

Coogle Chrome
Mail

0

GVESERT

&

Safari

Microsoft PowerPoint

TSP Monitoring |

Bl No speaker |

@) (22 @fd=

x © &=
]

Updating PRYIEGTGIATT

Create polls

You can create two types of polls: Yes/No and OK.

1. Click the Poll button in the toolbar or select Show Poll from the View menu to open the

Start a Poll popover.
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| Start a poll

(*) Yes/No poll
() OK poll

| Ask |

2. Select the type of poll you want to send and click Ask. This displays the appropriate Respond
to Poll action sheet to the participants.
3. Askyour question and then ask the participants to vote.

Related topics

"View the poll results" below

"Hide the popover" on the next page
"Detach the popover" on page 53
"Save the poll" on page 53

"Publish the poll" on page 53

"Stop the poll" on page 54

"Access the poll later" on page 54
"Participate in a poll" on page 30
View the poll results

After you create the poll, your Start a poll popover transforms into a Poll results popover and
displays the polling results online, in the form of a graph. The header displays the ratio of
participants who voted Yes or No from the total number of participants in the conference. The
body of the Poll results popover displays the choices, the number of participants who selected
each answer, and a graphic view of that number out of the total number of participants.

Published: 04/15/2016 AT&T Connect® Participant Application for Mac® User Guide 51
Product version: 11.6 © 2016 AT&T Intellectual Property. All rights reserved.



meE0.Ea0

‘ Poll results 3/4 =
Yes > 2
Ne 4 1
Ignored | 1
| Stoppoll |

Who voted what?

You can also see how each participant voted in the expanded Poll results popover.

o Click the arrow next to each answer to open the list of participants who selected that answer.

meEn.Ea0

‘ Poll results 3/4 (W ]
Yes v 2
Kelly Stone
Mike Novak
Ne > 1
Ignored | & 1
| Stoppoll |

Hide the popover

During a polling session, you can close the Poll results popover (maybe to view the entire
whiteboard).

o To hide the popover, click the active (blue) Poll button or select Hide Poll from the View
menu.

A badge appears above the Poll button with the ratio of the number of participants who
voted Yes or No from the total number of participants in the conference. This badge
indicates that the pollis still running.

&
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Detach the popover

You can extracted the polling popover to an external, floating panel and place it anywhere in the
window. You can then doc the popover (click the red button), and maximize or minimize it (click the
green or yellow button, respectively).

Save the poll
You can save the results of the poll locally as an RTF file.

1. Click the Save button in the popover’s toolbar. This opens the Save As action sheet with a
browser for selecting where you want to save the poll.

Save As: |_POII—3 | Izl

Where: | | ] accl76.uclabs.co...76655445... % |

| Cancel | [ Save ]

Save As: ‘_Poll—3 | |Z|

[«]»|[z2]= !E::! Im || 2= v || | accl76.uclabs.co...76... 3| (Q
e e

FAVORITES ording " [ acc176.ucla...445337283
& - " [ acc176.ucla...445337290
.
.
.

MeetingMinutes.xt

#N Applications [ acc176.ucla.. 445337389
@ [:l accl76.ucla... 448337404
Documents (] acc176.ucla...44$337407

[Z Internet Plug-Ins tppData [ acc176.ucla... 445337494
[ AutomaticBuilds [ acc176.ucla... 445337496
— [:l accl?6.ucla.. 448337529

L ATE e [ acc176.ucla...44$337537
SHARED [0 acc176.ucla...445337582

[:l accl76.ucla.. 4458337755

¥ Y Y YV Y YV VY Y Y YN YNYY

Q s iMac

_ [:l accl76.ucla . 448337778

2 digler {3 acc176.ucla...445337793

[ ilvi31 [ acc176.ucla...445337794

EJ itvils1 [:l accl76.ucla.. 445337796

= [[] acc176.ucla.. 445337814

| New Folder | |m|

2. Select the location and click Save.

Publish the poll

During the polling session, you can share the results of the poll on the participants’ whiteboards. If
the results change, the whiteboards will be updated.

o Click the Publish button in the popover’s toolbar.

)
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Relate topics
"View the results" on page 30
Stop the poll
o Click Stop poll to close the action sheet and remove the data.
Access the poll later

e Once the conference has ended, click on the conference under HISTORY in the Source List
window and locate the poll in the Conference Materials panel.

800 =

Co=& B0 =

MY CONFERENCE ROOMS
W @....com's Room @ Anna Clay’s Meeting ROOm History Options
Hosted by: Anna Clay

Room 3
Forward materials
Local Conference Information
UPCOMING CONFERENCES 6 Email all
FW: Mac Me.... at 10:15 AM @y
Mae Cliont - at 1130 AM (© 11/20/2012 | Started at 16:47, Ended at 17:09

CURRENT CONFERENCES 88 (innag ) ( Asafasasas | ozr | ( eladB
\'s Meeting Room 0
RECORDED CONFERENCES
1111
ver Meeting Minutes Snapshots ( Conference Materials )
HISTORY
. Meeting Room =
' Meeting Room Conference Name 's Meeting Room e
i , et e ) Poll-6 - Note
Wai's Meeting Room Started at : 11/20/12 17:10 B |r_d s
1..20/12 10:27 |‘_‘¢= B L
“..20/12 10:21 T o S
’ Action Items: : EEpr i
-19/1217:26 e | Ef—i
e /19/12 09:20 (exp: 17:20 Snapshot-1.tIff) e .
s e s
——— (exp: 17:20 Snapshot-2.tiff) Iz 1z |
L 24 /12 08:49 e o - E—
(exp: 17:20 Shapshot-3.tIfP) e N
. -23/12 09:03 — —
e toxm’ 1730 Snanchar.d riff) .
..16/12 13:23 s L )

1...15/12 09:21
SL07/12 10:56
o m12 1887

B |(Qsearch Conferen )

Conduct a web tour
Take the participants to websites or HTML pages.

1. Click on Web Tour then Start Web Tour on the Shared Content menu to display the
browser at the top of the whiteboard.

Note: The web browser is displayed only to presenters. Participants see content only.
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@ @ G Anna Clay is speaking (= P

[« ] [@)] [+ ] [mepi/sravelenn.comy

(&) [cosewebTaur | | (uy

Participants (4) v
- Mame @ © 0L
Add Bookmark RNATIONAL | us. | méxico | aramic Anna Clay (Host) @ g
R W & Travel
[Travel the World with CNN Travel for rave David Hall @O %
[ Add | Kelly Stone @‘ [« )
Mike Novak ® N
b World US. Amca Asia Ewope LstinAmerica MiddleEsst Business WorldSport Entortainment Tech [RISUNN Weport
Travel Home ~  Travel News ~Destinations ~  Guides | TV &Video ~ Galleries Q
QSearch Participants
My Meeting Minutes = |
g";;‘;lhsgﬁ ] =T snapshots |

FOLLOW CNN TRAVEL
Bue 2m v rolow S

FEATURE CNNGO TV SHOW
TR CNNGo TV in Paris:

4 Bread, music and
graffiti

¢ g CNNGo TV in Osaka

=2 and Kyoto: the

gw historic heart of
Japan

Where to see Africas big game

Nothing's guaranteed, but atcertain parks FZ=W 8§ CNNGo TV in

| frconent  zoom oo Snapshot Annotations

Enter the URL address and click Enter.

To navigate in the browser, click on the Back and Forward arrow buttons.

To refresh the browser, click the Refresh button.

To use choose a favorite site, click the Bookmark button to open the list of bookmarks and
select it.

6. To end the web tour, click the Stop Web Tour button on the toolbar or the Close Web Tour
button in the browser.

vk wnN

Related topics

"Add rename or delete bookmarks" below
Add rename or delete bookmarks

Add bookmarks for easy access to your favorite websites.

1. Click the Add button (to the right of the Bookmark button) at the web site you want to
bookmark to open the Add Bookmark popover with the URL address.
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[ 1
Add Bookmark

Ihttp:f!wwwm i) J
| Add |

2. Click Add.
To rename the bookmark:

1. Right-click the bookmark and click Edit Name to open the popover.
2. Edit the name and press Enter on the keyboard.

To delete the bookmark:

1. Right-click the bookmark and click Delete.
2. Press Enter on the keyboard.
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